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1. Présentation  
Ce mode d’emploi (IFU) décrit les fonctionnalités et les étapes nécessaires pour effectuer l’analyse des données à 

l’aide du logiciel AlloSeq cfDNA. Le kit de test AlloSeq cfDNA et le logiciel AlloSeq cfDNA sont désignés collectivement 

sous le nom de AlloSeq cfDNA. 

Un document séparé, le « Guide d’installation » (IFU106), a été établi pour la famille de produits logiciels AlloSeq. Il 

convient de le lire avant le présent mode d’emploi. 

1.1.  Présentation du système et du logiciel 
Le test AlloSeq cfDNA et le logiciel AlloSeq cfDNA (collectivement appelés AlloSeq cfDNA) forment un système qui 

permet la quantification relative de l’ADN acellulaire (cfDNA) dérivé du donneur dans un échantillon de cfDNA dérivé 

du receveur d’une greffe d’organe plein. L’ADN acellulaire est un ADN fragmenté présent dans le flux sanguin, 

provenant de cellules lésées ou qui meurent. 

 

Après l’extraction du cfDNA du plasma, le cfDNA est amplifié à l’aide du PCR multiplex comprenant des PCR primers 

pour 202  polymorphismes mononucléotidiques. Les produits PCR obtenus sont séquencés sur des séquenceurs MiSeq 

ou MiniSeq de Illumina, Inc. (Illumina), et les données des séquences sont analysées à l’aide du logiciel AlloSeq cfDNA. 

En l’absence d’informations sur le génotype du donneur ou du receveur, le cfDNA présent et formant le constituant 

mineur de cfDNA dans les transplantations cardiaques, rénales et pulmonaires est considéré comme étant « dérivé du 

donneur » (DeVlaminck et coll., 2014 ; Khush et coll., 2019 ; DeVlaminck et coll., 2015 ; Grskovic et coll., 2016 ; Bloom 

et coll., 2017 ; Bromberg et coll., 2017).  

 

AlloSeq cfDNA permet également l’amplification et le séquençage de l’ADN génomique afin d’identifier les génotypes 

du donneur, du receveur ou des deux sujets à des fins de recherche. Cette étape peut être effectuée avant ou en 

même temps que le test cfDNA. Elle est nécessaire pour quantifier le cfDNA dérivé du donneur chez les receveurs de 

transplantations hépatiques, chez lesquels les niveaux de cfDNA dérivé du donneur, contrairement aux 

transplantations rénales, cardiaques et pulmonaires, peuvent représenter la fraction principale du cfDNA total chez le 

receveur (Schütz et al., 2017).  

 

Il a été démontré qu’un niveau élevé de cfDNA dérivé du donneur est associé à une lésion et à un rejet de l’organe 

transplanté (Grskovic et al. 2016, Bloom et al. 2017, Bromberg et al. 2017; Khush et al., 2019; DeVlaminck et al., 2015). 

Les produits doivent être manipulés avec tous les soins et l’attention requis. Nous recommandons à tous les 

utilisateurs de lire l’intégralité du document avant de commencer la procédure.  

1.2. Utilisation prévue 
Le logiciel AlloSeq cfDNA est conçu pour être utilisé conjointement avec le test AlloSeq cfDNA pour calculer la 

quantité relative d’ADN acellulaire dérivé du donneur (%dd-cfDNA) chez des receveurs d'organes pleins. 

Le produit doit être utilisé dans des laboratoires soumis à une réglementation appropriée. 

L’utilisation du logiciel est exclusivement réservée au personnel de santé dûment formé exerçant dans des 

laboratoires agréés. Le logiciel ne doit pas être utilisé comme seule source d’information pour des décisions à des 

fins cliniques. Les kits et le logiciel AlloSeq cfDNA ne doivent pas être utilisés pour le diagnostic de maladies. 

1.3. Fichiers de données compatibles  
  
Le logiciel AlloSeq cfDNA est compatible avec le format de fichier zippé FASTQ (*.fastq.gz). Le système de séquençage 
Illumina génère ces formats de fichiers. Pour plus d’informations sur le format de fichier FASTQ, par exemple, consultez 
le Guide de référence du processus MiSeq ou MiniSeq Reporter Generate FASTQ (document n° 15042322).  
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1.4. Restrictions 
Le logiciel n’a pas été évalué à l’aide de fichiers fastq générés par : 

• Un séquenceur autre qu’un séquenceur MiSeq ou MiniSeq 

• Un séquenceur MiSeq ou MiniSeq utilisant des paramètres par défaut qui ne sont pas des paramètres 

Runtime par défaut 

• Identité génétique entre le donneur et le receveur 

AlloSeq cfDNA n’est pas en mesure d’effectuer une surveillance pour de vrais jumeaux.  

Lorsqu’aucun génotypage du receveur ou du donneur n’est fourni, le logiciel signale par défaut la fraction d’ADN 

acellulaire mineure comme étant la fraction du donneur. Si le donneur a le potentiel d’être la fraction majeure 

(>50 %), un échantillon de génotype pré-transplantation « receveur seulement » ou « donneur seulement » doit être 

utilisé afin d’affecter correctement la fraction au donneur. Le lien de parenté avec le receveur doit être fourni : 

sélectionnez parent, enfant, grand-parent, petit-enfant, frère ou sœur, demi-frère ou demi-sœur, tante, oncle, nièce, 

neveu, cousin, sans lien de parenté, autre (précisez) sous « Relatedness » (Lien de parenté) dans Donor Details 

(Renseignements du donneur).  Pour les receveurs de greffe hépatique, il est nécessaire d’avoir un seul génotype 

pour l’analyse.  Pour les receveurs de greffe hépatique, il est fortement recommandé, dans la mesure du possible, de 

disposer du génotype du donneur et de celui du receveur. 

2. Instructions pour les utilisateurs expérimentés 
1. Créez des Receveurs, ajoutez des Donneurs aux Receveurs, ajoutez des Échantillons aux Receveurs.  

2. Créez un Lot, ajoutez des Échantillons au Lot. « Generate Run Sheet » (Générer une feuille de traitement) 

pour le Lot.  

3. Exécutez le protocole de laboratoire, chargez le séquenceur.  

4. Une fois le séquençage terminé, « Analyze Results » (Analyser les résultats) pour le Lot, sélectionnez le 

dossier contenant les fichiers fastq.  

5. Échantillons de surveillance post-transplantation : examinez les résultats, marquez-les « Approved » 

(Approuvés) et exportez les résultats.  

3. Instructions pour les nouveaux utilisateurs 

3.1. Introduction 
La convention dans ces modes d’emploi est de mettre en majuscule les « entités » dans le logiciel AlloSeq cfDNA, telles 

que Receveur ou Échantillon, pour attirer l’attention sur un élément qui est suivi par le logiciel.  

Le logiciel AlloSeq cfDNA permet de suivre plusieurs tests de surveillance pour le même Receveur sur le long terme. 

D’autres résultats de test peuvent également être saisis dans le logiciel, tels que les résultats d’anticorps spécifiques 

du donneur (DSA) ou les résultats de créatinine rénale, qui permettront de mieux visualiser les derniers tests effectués 

pour le Receveur.    

AlloSeq cfDNA n’a été validé qu’avec du cfDNA extrait d’échantillons de plasma sanguin.  

3.2. Receveurs et Donneurs  
Le point de départ du logiciel AlloSeq cfDNA est de créer un Receveur et d’ajouter un Donneur à ce Receveur. Le Lien 

de parenté du donneur est requis car il appliquera un facteur de correction sur le résultat. Il est également possible 

d’ajouter au Receveur le Statut de la greffe (reçue ou requise/prévue) ainsi que les Traitements (interventions connues 

qui pourraient être utiles pour aider à interpréter les résultats du test).  

L’écran Receveurs est accessible depuis le menu principal à gauche (en cliquant sur la maison et en choisissant 

« Recipients » (Receveurs)) ou via le bouton rond de Démarrage rapide sur le Tableau de bord principal (l’écran de 

démarrage qui s’affiche après la connexion). 
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Une fois sur l’écran Receveurs, vous pouvez ajouter un nouveau Receveur en cliquant sur le bouton « New » 

(Nouveau). Vous pouvez également rechercher et choisir un Receveur existant. Le logiciel n’effectue aucune 

vérification des doublons pour les Receveurs. Il est donc préférable de commencer par vous assurer que le Receveur 

que vous souhaitez ajouter n’a pas déjà été ajouté dans le logiciel.  

L’écran Receveurs comprend une chronologie de tous les événements qui ont été enregistrés pour le Receveur, ainsi 

qu’un graphique qui résume toutes les mesures AlloSeq cfDNA (et autres tests) qui ont été effectuées. Vous pouvez 

ajouter des « Comments » (Commentaires) à chaque Receveur, ce qui peut être utile pour résumer l’état clinique 

actuel.  

Les Donneurs sont répertoriés en-dessous du graphique de l’écran Receveurs. C’est là que vous pouvez ajouter de 

nouveaux Donneurs et que vous pouvez modifier les Détails du donneur. 

 

3.3. Échantillons 
Une fois que vous avez créé le Receveur et le Donneur, la tâche suivante consiste à ajouter des Échantillons. Cette 

opération peut être effectuée sur l’écran Échantillons, accessible via le menu principal et le bouton de Démarrage 

rapide. Vous pouvez également y accéder depuis l’écran Receveurs.  

• Si vous commencez sur l’écran Receveurs, vous pouvez utiliser le bouton « Add » (Ajouter). La liste 

déroulante contient l’option « Sample » (Échantillon).  

• Si vous commencez sur l’écran Échantillons, vous pouvez sélectionner le bouton « New » (Nouveau) et 

choisir d’ajouter un « Recipient Sample » (Échantillon de Receveur) ou un « Control Sample » (Échantillon 

de contrôle). Vous serez ensuite invité à sélectionner un Receveur. C’est la seule façon d’ajouter des 

Échantillons de contrôle dans le logiciel. 
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Lors de l’ajout d’Échantillons, les seuls éléments de données obligatoires sont l’identifiant de l’Échantillon (il doit être 

unique parmi tous les Échantillons), la date de prélèvement de l’Échantillon et la concentration de l’ADN extrait (cette 

information n’est actuellement conservée qu’à des fins de référence). Notez que ces métadonnées de l’Échantillon 

peuvent être modifiées à tout moment.  

Sur l’écran Échantillons, il est également possible d’ajouter d’autres Mesures obtenues pour d’autres résultats de test 

effectués sur le même échantillon/au même moment. Pour AlloSeq cfDNA, il s’agit généralement des résultats sur le 

DSA ou sur le fonctionnement de l’organe pour l’échantillon. Vous pouvez également ajouter des « commentaires » à 

chaque Échantillon si nécessaire. 

 

3.4. Lots 
Les Lots sont un groupe d’Échantillons qui seront préparés ensemble à l’aide des réactifs AlloSeq cfDNA et séquencés 

ensemble. Vous pouvez créer un Lot à tout moment pour commencer à anticiper les prochaines semaines de test. 

Vous pouvez accéder à l’écran Lots via le menu principal et le bouton de Démarrage rapide. Vous pouvez également 

ajouter un Échantillon à un lot existant ou en créer un nouveau depuis l’écran Échantillons. 

Utilisez le bouton « New » (Nouveau) pour créer un nouveau Lot. Vous devrez ajouter une date et choisir « cfDNA » 

comme « Test Family » (Famille de test). Le nom du Lot est facultatif mais recommandé pour distinguer plus facilement 

un Lot d’un autre. Des commentaires peuvent également être ajoutés à un Lot. 
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Une fois le Lot créé, vous pouvez « Add Samples » (Ajouter des échantillons) et choisir les Échantillons de la liste que 

vous souhaitez tester dans le Lot. L’ordre des Échantillons dans le lot correspondra à l’ordre des index d’échantillons 

à utiliser à partir de la plaque d’indexage dans le kit de réactifs AlloSeq cfDNA.  

Remarque : l’ordre des Échantillons dans le Lot sera l’ordre dans lequel vous les ajoutez dans le Lot. La seule 

façon de modifier l’ordre consiste à supprimer les Échantillons et à les ajouter à nouveau.   

Une fois que vous avez ajouté tous vos Échantillons dans le Lot, vous pouvez choisir l’option « Generate Run Sheet » 

(Générer une feuille d’exécution), ce qui créera un nouveau fichier de feuille d’exécution au format CSV à utiliser sur 

le séquenceur Illumina. Cette feuille d’exécution peut également être imprimée et apportée au laboratoire pour 

faciliter la mise en correspondance de chaque Échantillon avec son index dans la plaque d’indexage.  

Remarque : des précautions s’imposent si vous ouvrez ce fichier dans Excel : enregistrer les modifications 

apportées au fichier CSV sous Excel peut l’empêcher de fonctionner sur le séquenceur Illumina ! Il est 

généralement plus sûr d’imprimer ce fichier sous Excel et d’effectuer toute modification (normalement non 

requise) à l’aide d’un éditeur de texte tel que Notepad++.  

Remarque : vous pouvez choisir un « Starting well » (Puits de départ) pour la feuille d'exécution : si vous avez 

choisi de diviser un seul kit AlloSeq cfDNA en plusieurs cycles de séquençage, vous pouvez définir un puits 

de départ différent pour les index. Les index de la feuille d’exécution seront utilisés pour démultiplexer les 

données de l’échantillon (c’est-à-dire décider quelles données appartiennent à quel échantillon) à la fin du 

séquençage.  

La feuille d’exécution peut être générée à nouveau à tout moment : si rien n’a changé dans le Lot, le contenu sera 

identique à chaque fois.  

Une fois la feuille de traitement générée, il est temps de passer au protocole de laboratoire AlloSeq cfDNA et de 

préparer les échantillons d’ADN pour le séquençage. 

Fonctionnalité Plan de plaque 

Un composant Plan de plaque a été ajouté au logiciel.  Son utilisation est facultative pour l’utilisateur final.  Cette 

fonctionnalité permet d’organiser le positionnement des puits sur le plan de plaque pour le fichier de sortie (feuille 

d’exécution). 
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3.5.  Analyse des résultats 
Une fois le séquençage terminé, un dossier contenant les fichiers fastq sera créé sur le séquenceur. Il y aura deux 

fichiers fastq par échantillon. Nous vous recommandons de copier-déplacer le dossier contenant les fichiers fastq vers 

le serveur pour l’analyse (l’accès aux fichiers fastq à distance sur un réseau peut ralentir l’analyse).  

L’analyse s’effectue en accédant à l’écran Lots, en sélectionnant le Lot approprié et en utilisant le bouton « Analyze 

Results » (Analyser les résultats). Vous serez invité à renseigner l’emplacement du dossier contenant les fichiers fastq. 

Le système vérifiera le dossier pour s’assurer que tous les fichiers de chaque Échantillon sont présents, puis il lancera 

une analyse. L’analyse prend environ 30 secondes par échantillon. Une fois l’analyse terminée, le système créera une 

nouvelle « Task » (tâche) pour chaque résultat. Ces Tâches seront attribuées à la personne qui a effectué l’analyse. 

Vous pouvez consulter vos Tâches dans le tableau de bord principal lorsque vous vous connectez. Ces Tâches peuvent 

être réattribuées à d’autres utilisateurs du logiciel si nécessaire. Ces Tâches resteront ouvertes jusqu’à ce que le 

résultat ait été « Approuvé » par un directeur de laboratoire (ou un super utilisateur).  

Remarque : les résultats s’afficheront dans les graphiques des écrans Receveurs et Échantillons, quel que 

soit leur statut d’approbation.   

3.6. Examen des résultats 
Un résumé de très haut niveau de la qualité de chaque résultat est visible sur le Tableau de bord et dans l’écran Lots : 

il s’affiche sous la forme d’un bouton à code couleur (vert, jaune ou rouge). Si le Résultat contient un avertissement 

(jaune) ou une erreur (rouge), la raison de l’échec de ce contrôle qualité (CQ) s’affichera dans l’onglet Contrôle qualité 

de l’écran Résultats.  

Les Résultats peuvent être consultés (et doivent être examinés) individuellement. Cependant, il est généralement plus 

significatif de commencer par examiner le Résultat résumé avec tous les autres résultats d’un Receveur dans l’écran 

Receveurs. Vous pouvez accéder à l’écran Résultats pour consulter les détails du Résultat en cliquant sur 

l’identificateur de l’Échantillon dans la chronologie de l’écran Receveurs (l’écran Échantillons s’ouvrira si vous n’avez 

pas encore de Résultat pour cet Échantillon).  

Vous pouvez également accéder au détail de chaque Résultat depuis le Tableau de bord principal en sélectionnant 

l’élément dans la liste des Tâches et en choisissant « View Results » (Afficher les résultats) dans le menu « Workflow » 

(Processus) ou en choisissant « Results » (Résultats) dans le menu « View » (Affichage). Vous pouvez également 

accéder aux Résultats depuis l’écran Échantillons (cliquez avec le bouton droit de la souris sur l’élément dans la liste 

« Tests » puis sur « View Results » (Afficher les résultats)).  

Une fois dans l’écran Résultats, les détails de l’analyse sont disponibles. Le Récapitulatif des résultats s’affiche. Dans 

le cas d’un suivi AlloSeq cfDNA, le Résultat indiquera les pourcentages exacts détectés pour chaque partie du mélange, 

par exemple, Receveur 99,5 % (supposé), Donneur 0,5 % (supposé). Le logiciel suppose que le signal le plus faible 

détecté appartient au Donneur.   

Le processus AlloSeq cfDNA peut être résumé comme de la façon suivante :  

1. Utilisez le test et le logiciel pour préparer et analyser les Échantillons de surveillance post-greffe pour le 

Receveur 

Le récapitulatif des Résultats indique le « Analysis Type » (Type d’analyse) utilisé pour l’analyse. Un seul Type 

d’analyse est utilisé pour le cfDNA :  

• À l’aveugle : effectué automatiquement pour tous les échantillons  

o Comprend un mécanisme de « outlier detection » (Détection des valeurs aberrantes), pour filtrer 

automatiquement tout résultat statistique aberrant 

o Restrictions : le système ne peut pas vous dire qui est qui dans le mélange. Il ne peut pas gérer 

plusieurs donneurs et a un « angle mort » de l’ordre de 30 à 70 % (des valeurs aussi élevées ne sont 

pas attendues pour le cfDNA) 

Il est possible de réanalyser les Résultats, en utilisant à nouveau le bouton « Analyze Results » (Analyser les 

résultats) de l’écran Lots.  
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Lors de l’examen des résultats, quelques éléments sont particulièrement importants :  

• Le Résultat principal, avec l’écart-type de tous les marqueurs informatifs 

• Le nombre total de Lectures traitées : généralement limité par le logiciel à un maximum de 3 millions de 

lectures par Échantillon. Si ce nombre est inférieur à 300 000 lectures, le système déclenche un 

avertissement de qualité (indiquant une perte potentielle de sensibilité pour les valeurs très faibles).  

• Couverture moyenne des marqueurs : quantité moyenne de lectures fastq couvrant chaque marqueur  

• Statut QC (contrôle de la qualité) : indique Réussi si tout est OK  

• Raison QC : s’affiche si l’état du contrôle qualité est « Warning or Failed » (Avertissement ou Échec). Les 

raisons motivant un problème de contrôle qualité peuvent être consultées dans l’onglet Contrôle qualité.  

 Plusieurs indicateurs de contrôle qualité sont mesurés. Le tableau suivant récapitule ces indicateurs de contrôle 

qualité.  

Remarque : les valeurs aberrantes sont détectées si la différence entre la valeur et la moyenne est supérieure à 5 fois 

la différence standard. Les marqueurs avec moins de 50 lectures ou avec un troisième signal significatif échoueront 

aux contrôles de qualité au niveau du locus. 

Name Analyse Type 

d’Échanti

llon 

Réussi  Avertiss

ement  

Échec  Description 

Trop de 

valeurs 

aberrantes 

À 

l’aveugle 

Tous <2 >=2 >10 Les valeurs statistiques aberrantes dans les résultats des 

marqueurs sont automatiquement détectées et exclues. Un 

nombre de valeurs aberrantes trop important peut indiquer 

une contamination ou une confusion dans l’échantillon. 

Marqueurs 

passant les 

filtres 

À 

l’aveugle 

Tous >186  N/A <=186 Nombre total de marqueurs qui réussissent tous les indicateurs 

de contrôle qualité au niveau du locus. Pour qu’un échantillon 

passe, le seuil minimal est de 92 % (186 marqueurs). 

Uniformité À 

l’aveugle 

Tous >=151 N/A <151 Pour qu’un échantillon passe le filtre d’uniformité, ≥75 % (151) 

des 202 marqueurs doivent avoir une couverture 20 % 

supérieure à la moyenne. 

Couverture 

moyenne des 

marqueurs 

À 

l’aveugle 

Tous >=400 <400 <250 Nombre moyen de lectures couvrant chaque marqueur. Un 

nombre de lectures insuffisamment élevé entraînera une perte 

de sensibilité (avertissement) ou un résultat peu fiable (échec). 

Nombre total 

de lectures 
À 

l’aveugle 

Tous >300k <=300k <=150k Nombre total de lectures traitées. Un nombre de lectures 

insuffisamment élevé entraînera une perte de sensibilité 

(avertissement) ou un résultat peu fiable (échec). 

 

Par défaut, seuls les SNP les plus significatifs sont affichés. Si vous le souhaitez, vous pouvez choisir d’autres options 

pour filtrer la liste des SNP, dont l’affichage de tous les résultats SNP. Un SNP sera considéré comme significatif s’il est 

déterminé comme étant homozygote.  

L’onglet « Statistiques » fournit des points de données supplémentaires pour ceux qui s’intéressent davantage à la 

bioinformatique sous-jacente.  

Lorsque vous êtes satisfait des Résultats, vous pouvez les envoyer pour approbation au directeur du laboratoire afin 

qu’il les approuve et les exporte. Les Résultats peuvent être exportés aux formats CSV, TSV ou PDF. Plusieurs Résultats 

peuvent être exportés ensemble depuis le Tableau de bord principal ou la liste des tâches. 
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4. Résolution des problèmes 
Si tous les indicateurs de contrôle de la qualité sont verts/réussis, il n’est pas nécessaire de procéder à une résolution 

de problèmes sur les résultats.  

Les indicateurs de contrôle qualité jaunes/Avertissement indiquent qu’un point du résultat nécessite un contrôle manuel. 

Dans ce cas, les résultats ne seront pas affectés et pourront être transmis. Les indicateurs de contrôle qualité 

Avertissement peuvent également fournir des informations générales si d’autres mesures de contrôle qualité ont échoué. 

Les indicateurs de contrôle qualité rouges/Échec indiquent que le résultat est incertain. Dans certains cas, il est encore 

possible d’accepter et de transmettre des résultats présentant des échecs de contrôle qualité. Voir les exemples ci-dessous.  

Un séquençage profond est nécessaire pour une sensibilité maximale 

AlloSeq cfDNA ne peut pas fournir les niveaux de sensibilité les plus élevés si un nombre de données de séquençage 

insuffisant a été créé par la préparation et le séquençage d’un échantillon. Dans ce cas, l’échantillon sera marqué 

comme ayant échoué au contrôle qualité du fait des indicateurs de contrôle qualité pour la couverture moyenne des 

marqueurs et/ou du nombre total de lectures dans ce cas. Cependant, si le résultat est supérieur à 1 %, les pertes de 

sensibilité n’auront pas d’impact majeur et le résultat pourra probablement être transmis malgré tout (à moins que 

d’autres indicateurs de contrôle qualité n’aient également échoué). Si le résultat est inférieur à 1 %, il est recommandé 

de répéter l’échantillon (répéter la préparation de l’échantillon en commençant par le début du protocole d’essai).  

Lot bruyant  

Si plusieurs échantillons de génotype d’un Lot échouent avec le paramètre de contrôle qualité « bruit » et/ou si 

plusieurs échantillons de surveillance échouent avec l’indicateur de contrôle qualité « Signal mineur inattendu », 

cela est probablement dû à une contamination de l’index causée par l’utilisation des mêmes index d’échantillon que 

lors du séquençage précédent et/ou à la non-conformité du nettoyage du séquenceur entre les passages par rapport 

aux directives du mode d’emploi du test. Les échantillons de surveillance avec de faibles résultats devront 

probablement être répétés. 

5. Références 
Circulating cell-free DNA enables noninvasive diagnosis of heart transplant rejection, DeVlaminck et al., Sci Transl Med. 

2014 Jun 18;6(241):241ra77 

 

Noninvasive detection of graft injury after heart transplant using donor-derived cell-free DNA: A prospective multicenter 

study, Khush et al., Am J Transplant. 2019 Mar 5. doi: 10.1111/ajt.15339 

 

Graft-derived cell-free DNA, a noninvasive early rejection and graft damage marker in liver transplantation: A prospective, 

observational, multicenter cohort study, Schütz et al., PLoS Med. 2017 Apr 25;14(4):e1002286 

 

Noninvasive monitoring of infection and rejection after lung transplantation, DeVlaminck et al., Proc Natl Acad Sci U S A. 

2015 Oct 27;112(43):13336-41 

 

Validation of a Clinical-Grade Assay to Measure Donor-Derived Cell-Free DNA in Solid Organ Transplant Recipients, Grskovic 

et al., J Mol Diagn., 2016 Nov;18(6):890-902 

 

Cell-Free DNA and Active Rejection in Kidney Allografts, Bloom et al., J Am Soc Nephrol., 2017 Jul; 28(7):2221-2232 

Biological Variation of Donor-Derived Cell-Free DNA in Renal Transplant Recipients: Clinical Implications. Bromberg et al., 

JALM, 2017 Nov; 2(3): 309-321 

 

Repeat kidney transplant recipients with active rejection have elevated donor-derived cell-free DNA, Mehta, et al. Am J 

Transplant. 2019 May;19(5):1597-1598 

 

Interference Testing in Clinical Chemistry; Approved Guideline—Second Edition, EP7-A2 (ISBN 1-56238-584-4)  



Pour une utilisation diagnostique in vitro Page 11 sur 12  Version : 1.0 

6. Coordonnées 
Fabricant : 

CareDx Pty Ltd,  

20 Collie Street, Fremantle, WA, Australie, 6160. 

Tél : +61 8 9336 4212 

E-mail : orders-aus@caredx.com 

Site Web : http://www.caredx.com 

 

Importé / distribué par : 

Asie-Pacifique (APAC) 

CareDx Pty Ltd,  

20 Collie Street, Fremantle, WA, Australie, 6160. 

Tél : +61 8 9336 4212 

E-mail : orders-aus@caredx.com 

Site Web : http://www.caredx.com 

 

Europe (Importateur), Moyen-Orient et Afrique (EMEA) 

CareDx AB,  

Franzéngatan 5, SE-112 51 Stockholm, Suède.  

Tél : +46 8 508 939 00  

Fax : +46 8 717 88 18  

E-mail : orders-se@caredx.com  

Site Web : http://www.caredx.com/  

 

 

Soutien technique :  

E-mail : techsupport-global@caredx.com  

 

Pour plus d’informations, veuillez consulter le site Web de CareDx (https://www.caredx.com/contact-us/).  

 

Produits connexes : 

AlloSeq cfDNA 
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Historique de la méthode  

Version Date Modification (IFU091-FR v1.0 est traduit du document principal en anglais 
IFU091_AlloSeq cfDNA Software IFU CE v8.0) 

IFU091 
v1.0 

16 déc. 19 Première version du mode d’emploi du logiciel AlloSeq cfDNA pour la version CE. 

IFU091 
v2.0 

25 mars 21 Modification du distributeur de Vienne à Stockholm dans la section 8.0. 

IFU091 
v3.0 

17 mai 22 Mise à jour du logo, mise à jour des coordonnées du représentant de la CE, ajout d’un 
importateur pour l’UE, mise à jour de la formulation de la section Utilisation prévue  

Suppression des sections Installation (désormais incluse dans le guide d’installation), 
analyse logicielle, processus logiciel, et remplacement par des instructions pour les 
utilisateurs expérimentés et pour les nouveaux utilisateurs. Mise à jour de la formulation 
pour la résolution des problèmes et ajout de restrictions.  

IFU091 
v4.0 

24 mai 22 Mise à jour des restrictions de la section 6 pour greffe de donneur vivant apparenté. 

IFU091 
v5.0 

25 juil. 23 Suppression de la section 2. La « Description du produit » ne concerne que le logiciel v1.  

Suppression de la section 6 « Limitations» et déplacement à la section 1.4 Restrictions 

Ajout de MiniSeq en tant qu’équipement validé 

Ajout d’une fonctionnalité optionnelle Plan de plaque à la section 3.4 « Lots », comme 
utilisation optionnelle des fonctionnalités 

IFU091 
v6.0 

18 oct. 23 Mise à jour à la section 3.2 « Receveurs et Donneurs ».  Après avoir ajouté le Donneur au 
Receveur, Lien de parenté si nécessaire. 

IFU091 
v7.0 

24 oct. 23 Ajout des coordonnées du représentant suisse.  

IFU091 
v8.0 

11 janv. 24 Mise à jour du numéro de version logicielle pour la version v2.2.1.  

IFU091-
FR v1.0 

27 mars 24 La première traduction en français. 

 


